
Call for Condensed Papers, Second Africa Congress on Conservation Agriculture, J’ burg, South Africa, 9-12 October 2018. www.act-africa.org 
1 

 
African Conservation Agriculture Network 

 
 

SECOND AFRICA CONGRESS ON CONSERVATION AGRICULTURE (2ACCA) 
 

9th – 12th October 2018, Johannesburg, South Africa 

 

Call for Condensed Papers 

 
Theme: 

"Making Climate-Smart Agriculture Real in Africa with Conservation 
Agriculture: Supporting the Malabo Declaration and Agenda 2063” 

 

Deadline 31th May 2018 
 

Background 

 

The African Conservation Agriculture Network (ACT) in collaborating with the Government of South Africa, 

African Union Commission, the NEPAD Agency, Regional Economic Communities, International NGOs, 

Norwegian Agency for Development Cooperation (NORAD), European Union (EU), and the Food and 

Agriculture Organization (FAO) of the UN, invites you to the Second Africa Congress on Conservation 

Agriculture (2ACCA), in Johannesburg South Africa, from 9th to 12th October 2018.  

 

The aim of 2ACCA is to bring together expert knowledge, information, and insights from practitioners from 

across different sectors and interests groups at all levels of agriculture development in the public, private and 

civil sectors. This diversity of knowledge and stakeholders is essential: (a) to enable the desired multi-

disciplinary and cross-sector “treatment” of CA as a climate-smart agriculture; and (b) for the sustained 

mobilization of policy, institutional and community support to accelerate the widespread adoption and 

management of CA as a core element of the expanding climate-smart food and agriculture systems in Africa. 

This is in line with the Malabo Declaration, AU’s Agenda 2063, and the SDGs.  

 

Thus, the purpose of the 2ACCA initiative is to facilitate diverse and open sharing of experiences and 

information on CA thereby fostering learning and widespread awareness and interest in the uptake and spread 

of CA. This includes CA’s role in: enhancing sustainable agricultural productivity and economic return, 

strengthening environmental and social resilience, and fostering efforts to provide for food and nutrition 

security as well as jobs and economic opportunities, especially for rural communities, including youth and 
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women. The 2ACCA initiative provides a “neutral space” for networking, collaboration and partnership to 

support the scaling-up of CA systems as CSA across Africa. 
 

This call for condensed papers is extended to all potential participants who wish to make an oral or a poster 

presentation relevant to the Congress theme and any of the specific sub-themes as stated below. Authors 

should indicate whether they wish to do oral or poster presentations. Specifications for the posters are 90 cm 

wide, 120 cm high, with letter sizes readable from 2 m and with a good mix of photos, diagrams, tables and 

maps. 

Theme: The theme of the congress is “Making Climate-Smart Agriculture Real in Africa with Conservation 

Agriculture: Supporting the Malabo Declaration and Agenda 2063”.  

 

Sub-themes: 

1. Role of CA in achieving Agenda 2063 goals and SDGs in Africa for building climate-smart 

agricultural systems  

2. Mainstreaming of CA paradigm at the institutional and sectorial level and within governments’ 

systems in bringing about the sustainable transformation of agricultural systems in Africa 

3. The critical role of mobilizing institutional support from the public, private and civil sectors, and 

catalysing local and regional CA scientific and technological innovations and practices in 

overcoming adoption constraints   

4. Enhancing CA related education and training-learning capacity and creating an enabling policy 

environment in support of the “last-mile” institutions and stakeholders to accelerate and expand the 

uptake of CA systems and practices 

5. Investing across institutions and sectors for widespread adoption and commercialization of CA 

systems for achieving Agenda 2063.  

6. CA knowledge system management and information sharing capacity development for impact. 

 

Template for Condensed Paper submission to 2ACCA 
 

This MS Word.doc file has been formatted using the style-sheet required for your condensed paper. Use the 

styles as presented in this template or follow the formatting instructions below or in the annexed ‘sample 

paper’. 

 

Important notes to all authors 

 In the normal course, editors will not accept more than one opportunity for revision. 

 Condensed papers are limited to a maximum of 3 pages including text, tables and or figures and 

references. 

 The Title should be brief but specific to the subject of your paper. 

 The condensed papers should be structured in the following sections: Introduction, Methods, Results & 

Discussion, References, Graphs and Tables (though variations might be accepted). 

 Authors’ names and addresses should be shown below the title, as specified under Author’s names and 

Author’s addresses below. 

 A selected number of the best condensed papers will be identified for publication as full papers in a 

range of scientific journals or a book. 

 

Language 

Condensed papers must be in either English or the French language. 

 

File name 

Name your completed Word document as follows:  

2ACCA2018underscore last name plus initials.doc (e.g., 2acca2018_mkomwas.doc). Use all lowercase.  

 

Text 

 Use “Times New Roman” for all text including headings. Left align all text, images and tables. 

 Use the Normal style for all text (style-normal) where possible in preference to "Body text" styles. 

Normal text should be font size 12, with single line spacing. 
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 Do not indent the first line of a paragraph. Leave one blank line between paragraphs and before new 

section headings. 

 Authors’ email and web addresses may be hyperlinked. Hyperlinks to external web references should be 

placed in the References section, rather than in the body of the paper. 

 Use List Bullet or List Number styles where appropriate for dot point or numbered lists. 

 

Headings and sections 

 Paper title: 14 font size, bold, sentence case (capitals for proper nouns only). If the title extends to a 

second line, do not use “enter” to break the line. Leave one blank line below the title. 

 Authors' names: 12 font size. First name initials should come after the family name for each author. 

Highlight the presenting author in bold. Use superscripts to indicate different addresses. 

 The Email address of the corresponding authors should be provided below the affiliation. 

 Section Headings: 12 font size, bold, not italic for Headings 1, and 11 font size italic for Headings 2.  

Use descriptive names for Section headings where appropriate but Introduction, Material and 

Methods, Results and Discussions and References. 

 Keywords heading: 11 font size, bold. 

 Keywords: (style-keywords) 11 font size, not bold. Up to five key words not used in the Title. Leave 

one blank line below the key words. 

 References: A simplified form of the Harvard system (also known as the author-date scheme) with 

minimal punctuation is suggested (see also attached example).  

 

Figures and images 

 No colour printing will be available in the book of condensed paper, so make sure that your graphs, 

symbols and figures are readable in a black and white print. 

 Figures and images should be placed in the additional page following the references. Figures and images 

should be self-explanatory e.g. should include caption description. 

 Images in either colour or black and white are acceptable. Images files can be inserted using 

Insert>Picture>From File. Suitable formats include JPG, GIF, BMP and TIFF. Images should be 

cropped and reduced where possible to produce a file size of around 300kb or less before inserting into 

Word. 

 A table with borders removed can be used to arrange two or more images or figures side by side. 

 If the drawing tool is used to create a diagram, group the objects using the Select Objects arrow on the 

Drawing toolbar and then choose right-click>Grouping>Group. 

 Captions for Figures and images should be 11 font size, left aligned, placed below the image. 

 

Symbols 

 As far as possible use Insert>Symbol and select a character from the "normal-text" font set at the top 

of the Font drop-down list rather than the "Symbol" or "Wingdings" font set. 

 

Tables 

 Use tables, do not use tabs or spaces to align images and text. Remove borders from tables and insert 

horizontal lines only as illustrated (Table 1) using Format>Borders and shading.  

 Use the Insert Table button on the Standard toolbar and left align tables. Keep formatting simple. 

 Captions should be placed above the table using the same Caption style and 11 point. 

 Data columns should generally be centered or left aligned. 

 

Page Layout 

 Margins should be set at 2 cm all round. 

 Do not indent paragraphs. 

 

The papers will be studied in strict confidence by pre-selected members of the scientific committee. In case of 

acceptance, the author will be notified of the acceptance of the paper and/or any requested adjustments. All 

contributions will be summarized in a book in French and English versions, which will be distributed to 

participants before the beginning of the congress. The best contributions will be selected and authors requested 

to refine their texts into full papers for publication. 
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Paper submission 

Submit condensed papers for consideration to the following link: www.africacacongress.org/call-for-

papers.html 

 

A number of selected distinguished posters and videos will be honoured during the Congress. 

 

Calendar and key deadlines 

 1st February 2018: Registration (online) opens  

 30th March 2018: Early bird registration deadline   

 31th May 2018: Deadline for submission of condensed papers 

 30th June 2018: Deadline for submission of revised condensed papers 

 9th – 12th October 2018: Congress and field tour 

 

The Congress programme will include: Plenary Keynotes and Panel Sessions; Case Studies; Special working 

groups (thematic parallel sessions); Field Visits; Poster/video sessions; Open time and information kiosks; 

Special Farmers’ Session; stalls and display of equipment and machinery. 

 
 

For further information visit: www.africacacongress.org, www.act-africa.org  

Or Email: cacongress@act-africa.org or helpdesk@act-africa.org  

  

http://www.act-africa.org/
http://www.africacacongress.org/call-for-papers.html
http://www.africacacongress.org/call-for-papers.html
http://www.africacacongress.org/
http://www.act-africa.org/
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Annex: Sample Condensed Paper 

 

Maize Yield Increases and Stabilization under Conservation Agriculture in 

Semi-arid Districts of Tanzania 
 

Mkomwa S1, Mkoga Z2, Mariki W3 and Owenya M3 
1African Conservation Tillage Network. P. O. Box 10375 00100 Nairobi Kenya 

Corresponding author: saidi.mkomwa@act-africa.org 
2Uyole Agricultural Research Institute. P. O. Box 400 Mbeya Tanzania 
3Selian Agricultural Research Institute. P. O. Box 624 Arusha Tanzania 

 

Keywords: smallholder farming, direct seeding, ripping, cover crops 

 

Introduction 

 

Frequent crop failures resulting from improper farming practices have entrenched erratic food 

supplies and extreme poverty in the semi arid areas of Tanzania. The conservation agriculture (CA) 

intervention aims at promoting practical, short term outcomes to help farmers optimise both their 

labour output and utilization of existing resources to maximize capture and retention of soil 

moisture, expand their cropping options while sustainably conserving their farm lands, and reduce 

the vulnerability of farm incomes. The Conservation Agriculture for Sustainable Rural 

Development (CA for SARD) phase 1 was a Project funded by the Government of the Federal 

Republic of Germany and executed by the Food and Agriculture Organisation (FAO) of the United 

Nations. Regional coordination and administration functions were performed by the African 

Conservation Tillage Network (ACT). The project aimed to contribute to the promotion of growth 

and improved food security in Kenya and Tanzania through the scaling up of conservation 

agriculture as a sustainable land management (SLM) tool. Through an increase in the numbers of 

CA farmer field schools, the Project was to expand the adoption of profitable CA practices by 

smallholder farmers in the two East African countries. To facilitate the scaling out process the 

Project enhanced the supply and availability of CA equipment for farmers by stimulating private 

sector participation in the manufacture, retailing and hiring of equipment. 

 

Material and Methods 

 

This paper is based on the findings from samples of six to eight farmer field schools (FFS) from a 

total of 14 from Arumeru and Karatu Districts in Arusha Region Tanzania for three consecutive 

years from 2005 to 2007. Names of the FFS with villages in brackets include Ekenyo 

(Kilimapunga); Ikenya (Ikiushin); Ujamaa (Rhotia Kati); Tumaini (Getamock); Kinara (Tloma) and 

Upendo (Likamba). The gender mixed farmer groups constituted 20 – 25 smallholder farmers and 

were formed by voluntary membership to establish learning by experimenting with alternative crop 

production technologies. Participating farmers were guided by village group facilitators and ARI 

Selian research scientists to select tillage, weed control and cover crop treatment options considered 

“best bets” in ameliorating deficiencies in soil and water resources. Selected treatments were as 

follows: (1) Jab planter, glyphosate weed control, lablab cover crop planted after first weeding, (2) 

Ripping (ox ripper), glyphosate weed control, jab planting in the ripper furrow, pigeon peas 

intercrop, (3) Jab planter, glyphosate weed control, pigeon peas intercrop, (4) Ripping, glyphosate 

weed control, jab planter, lablab cover crop and (5) Farmers practice - ox ploughing, hand hoe weed 

control. Plot sizes varied from one FFS to another, ranging from 390 to 1440 m2.  The ox ripping 

treatment was imposed before the first rains when the soil was friable, and to ensure the first rains 

were harvested with no runoff losses. Field data was collected by the farmers themselves through a 

participatory monitoring and evaluation approach that incorporated the empowering agricultural 

ecosystem analysis (AESA).  Data was collected on rainfall, labour input for the field operations, 
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soil property changes, crop disease and insect attack/coping strategies, maize grain yield and cover 

crop grain yield. Recommended agronomic packages in terms of crop spacing and use of improved 

maize seeds were practiced. However, none of the FFS used industrial fertilizers or manure. 

 

Results and Discussion 

 

Effect of tillage. Ripping with either lablab or pigeon peas as cover crops produced significantly 

different and higher grain yields (of 1,949 and 2,043 kg ha-1 ) compared to direct seeding with the 

jab planter (1,735 and 1,770 kg ha-1 ) and conventional ox ploughing (1,353 kg ha-1) during the first 

year of CA (Table 1). This was a relatively dry year with annual precipitation of 528 mm. The trend 

in yield increase differences continued during the second year with a relatively better rainfall of 755 

mm. However, the higher yields in ripped sub-plots were not maintained in year 3 but were 

exceeded by the jab planter with a substantial soil cover of lablab (1,973 and 1,320 kg ha-1 for 

ripping with lablab and p/peas respectively compared to 2,738 for jab planting with lablab). The ox 

ploughed plots produced the lowest grain yield throughout. 

Effect of cover crops. The direct seeded jab planter treatments produced the second lowest and 

significantly different yields during year 1. Yield trends changed in year 2 as the interaction of the 

established cover crops on tillage treatments started to have an effect. While ripped plots with 

pigeon peas produced the highest yields (3,018 kg ha -1 it was not significantly different to others, 

except the farmers practice), ripping with lablab produced the lowest yield of the tillage & cover 

crop treatments. The yield increase trends were consistent for lablab which produced and 

maintained the highest yield of 2,738 kg ha-1 in year 3 (in a year with a grand mean of 1,697 kg ha-

1) while pigeon peas dropped drastically to 1,320 kg ha-1.  

Yield variations across sites. Yields across different FFS varied greatly (from a maximum of 7.6 

tons/ha in Rhotia Kati for ripper with pigeon peas to 0.2 tons/ha for the farmers’ practice in 

Getamock), which was understandable due to the differing farmer management skills and the initial 

degraded status of the fields.  

Preferred CA technologies. Participating FFS members were encouraged to choose preferred CA 

technological packages for implementation in their individual farms. Of the 352 households 

practicing CA, 206 (64%) are FFS group members while the remaining 146 are non-FFS members 

enticed by the benefits of CA. The preferred planting/tillage technologies are the ripper (61%) for 

FFS members; most of them complimented by the jab planter for seed placement, while a few 

farmers place the seeds manually in the ripper furrow and cover by foot.  

Gender implications to CA. Women constituted 33% of the members of the FFS during formation 

of the groups. Of the total 206 adopters from 8 FFS, 136 (66%) are women. Interviewed farmers in 

Karatu explained that 90% of their active participants are women who see an opportunity to feed 

their families, improve livelihoods and that most of the men are no longer available for agricultural 

work as they are employed in the tourism industry. 
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Figures and Tables 
 

 
Figure 1.Maize grain yields (kg/ha) with different CA treatments and over time in Arumeru and Karatu 

Districts in Arusha Tanzania. 

 

Table 1. Maize Grain Yield (Means for 6 FFS plots) 

 

No. Treatment Maize grain yield (kg/ha) 

2005 2006 2007 

1 Jab planter, glyphosate, lablab 1,735 2,889 2,738 

2 Ripping, glyphosate, jab, p/peas 1,949 3,018 1,973 

3 Jab planter, glyphosate, p/peas  1,770 2,566 1,369 

4 Ripping, glyphosate, jab, lablab 2,043 2,357 1,320 

5 Farmer’s practice, ox ploughing 1,353 1,502 993 

 Grand mean 1,770 2,466 1,679 

 Annual rainfall (mm) 528 755 988 (5321) 
Source: ARI Selian field data, 2007; Arusha foundation seed farm (some rainfall records). 

 

Table 2: Percentage of adopters within 8 FFS practicing different aspects of CA 

 

No CA Technique Percentage practicing Total CA adoption 

FFS members 

(206) 

Non-FFS 

members (146) 

1 Ripping 61 56  

2 Hand hoe planting 2 39  

3 Direct seeding – jab planter 57 26  

4 Direct seeding – direct seeder 12 20  

5 Lablab 66 67  

6 Pigeon peas 69 53  

 Adoption (compared to base)  151  

 Area (hectares under CA) 60 71% 

 Average household area (acres) 0.75 1.03  

 

                                                           
1Although the annual precipitation was high (988 mm), distribution was poor as only 532 mm were available for the cropping season. 
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